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CMPE 101 – EXPERIMENT 1* 

INTRODUCTION TO MICROSOFT WORD AND EXCEL 

Aims 

1. Getting used to the Graphical User Interface (GUI) of Windows Operating Systems. 

2. Understanding how word processors work and developing the ability to create various types 

of documents using Microsoft Word 2007. 

Note: We will be using Microsoft Word 2007 in these experiments; however, the use of other word 

processors are also similar. 

Preliminary Explanations 

Word processors are the programs that are used to create, edit, print and save documents. It is 

possible to create reports, papers, announcements or even books using a word processor. This week 

we will be experimenting with Microsoft Word 2007. Since this program has many features, it is not 

possible to cover all topics. However, after this experiment, you will be able to use most required 

functionality. Other features can be learned using the “Help” menu. 

Writing Text 

When you open Microsoft Word, a new blank document will be ready for you. You may write 

whatever you like on this page. Anything you write will be displayed on the screen. 

Note: Use the enter key to create new paragraphs; not to end sentences or lines. 

Text Selection 

Using Mouse 

1. Position your mouse cursor over the beginning of the text you want to select. 

2. Holding the left mouse button, move the mouse button to the end of the text 

3. Release the left mouse button 

Using Keyboard 

1. Position the text cursor (blinking line) to the beginning of the text using direction keys on 

your keyboard, 

2. Holding the Shift button, go to the end of the text you want to select, again use direction 

                                                 
* Translated by Cem Kalyoncu and Yıltan Bitirim for CMPE 101 from BLGM 101 course laboratory sheets. 
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keys to move. 

3. Release the Shift key. 

After text selection, you may perform various operations. For instance, you may copy the text and 

paste it somewhere, make it bold, change its size, font or color. 

Cut, Copy and Paste 

You should select a text to copy or cut it. After selection you can use either “Copy” (CTRL + C) or 

“Cut” (CTRL + X) command. You can access these commands from the menu shown in Figure 1 

You may use cut operation to move the text and copy to duplicate it. After issuing one of these 

commands, place text cursor to the place you want and issue “Paste” (CTRL + V) command. 

Note: You may paste a copied text as much as you like 

Use of Menus 

In the figure below the main menu commands are shown. Details of these commands are given in 

the following chapters. 

On the top of the screen, there is a bar where the menus (Home, Insert, Page layout, etc...) are 

located. You may perform many operations using these menus. It is impossible to cover all menu 

functionality in one experiment; however, you may try to learn these uncovered functionality in 

Figure 1: Main menu 
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your free time. Help Menu is the best source of information. You may access to help menu using 

symbol located on the menu bar. 

You may access File menu from the top left corner of the screen using symbol. The “New” 

command in this menu creates a new empty document. You may load a previously saved document 

using “Open” command. “Save” command is used to save your document. You may use “Save as” 

command to save your document with a different name. “Close” command will close active 

document. While the office menu is open, recently used files will be listed on the right. You may 

also open the document you want from this list by clicking on it. You can also save your document 

using the disk ( ) button. To undo an operation that you do, you can use back arrow icon ( ) 

which is located next to disk icon. 

Changing Font Type and Font Size 

In Microsoft Word 2007 starting font is Calibri with the size of 11 points. You can change the font 

type and size using the “Font type” and “Font size” sections, which are shown in Figure 1  Ready to 

use styles are located on the right side of the main menu and can be helpful for this matter. In fact, 

its advised to use these styles for headers. 

Example: 

This sentence is written with size 8. This sentence is written 

with size 20. 

Usually “Times New Roman” is preferred in academic papers. This document is also written in 

“Times New Roman” font type. If you wish to place program codes in your document, using 

“Courier New” type fonts will make them more readable:  

Example 

int main() { 

     return 0; 

} 

When necessary, you may make a part of you text bold, italic or underline. In general you should 

make keywords in your document bold. Italic is used emphasize the importance of words. In 

English underline is not commonly used. These styles can be used together as well. 
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Example: 

Which of the following is not an input/output unit. 

This text is both italic and bold. 

Using alignment buttons shown in Figure 1 you may change the alignments of paragraphs. The 

alignment types are “Left aligned”, “Right Aligned”, “Centered”, and “Justified”. Justified aligns 

both sides of the text to the document. 

You may use “Margins” button from the “Page layout” menu to adjust margins of your document. 

There some ready options in this list, however, you are allowed to customize margins using 

“Customize margins” option. If you are required to divide your document into columns, you may 

use “Columns” button from the “Page layout” menu. You may select a ready option or design your 

own column system using “More columns” option. 

Using Shortcut and Access Keys 

Many of the menu commands can be accessed using a keyboard shortcut. Shortcuts can be used 

instead of clicking to speed up your work. For instance, instead of using save button from the 

toolbar, you can use CTRL + S key combination. To do that, press S key while pressing Ctrl key. 

The following is the list of most used shortcuts: 

CTRL + C: Copy 

CTRL + X: Cut 

CTRL + V: Paste 

CTRL + Z: Undo 

CTRL + S: Save 

CTRL + P: Print 

When you press Alt key, some letters will be shown on menu items. You may press these keys while 

holding Alt key to perform the operation you want. 

  Tables 

To insert a table you can use “Table” button from the Insert menu. After clicking this button select 

number of rows and columns. This operation will create a new table. You may use TAB key to 

move between the cells of your table. If you press TAB in the last line, a new line will automatically 

be inserted for you. 
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You may exercise by creating the table below. 

Example: 

Student No Name Surname City Country 

107305 Gabriel Vazquez Riverside Liechtenstein 

103170 Iris Hutchinson Kearns Angola 

109510 Kuame Phelps Jordan Valley Virgin Islands 

100833 Rajah Gamble North Charleston Hungary 

 

You can use “Design” menu to adjust a table. You must select a table to see Design menu. Similarly 

you can change row and column data using “Layout” menu. 

Equations 

There is a tool offered in Office 2007 to create and edit your equations. To insert a new equation  to 

the document, use Equation button from the Insert menu. This operation will create a region for you 

to write your equations and a menu. Using this menu you can add mathematical symbols to your 

document. 

Example: 

 

Experimental Work 

1. Start the Microsoft Word by finding it from the Start menu. Please type in the first paragraph 

of Preliminary Explanations section and duplicate this paragraph for five times. You should make 

copies in separate paragraphs. 

 Use “Times New Roman” sized 12 points. 

 Underline all “word processor” texts 

 Make all “this” and “and” words bold 
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 Change font type of “Microsoft Word 2007” to “Courier new”. 

 Change the size of “help” word to 16 points. 

2. Change the alignments of these paragraphs. 

3. Create a table containing student number, name, surname and age. These headers should be 

in the first row, make them bold. Enter your own information to second, and information of your 

friend to the third. 

4. Recreate all the equations within this document. 

 

PART II - MICROSOFT EXCEL 

Preliminary Explanations 

Spreadsheets help us with poll results analyzing, statistical summary creation, financial decision 

making, and accounting. This week will be working on Microsoft Excel 2007. Since this application 

has many functionalities, it is not possible to cover all in a single experiment; however, after this lab 

session, you will be completed most common tasks. More importantly, you will be able to learn 

other features using the help menu. 

After you start Excel, a new worksheet will be waiting for you. This worksheet is divided into cells 

like a table. Columns are addressed by numbers (1, 2, 3...) while columns are addressed by letters 

(A, B, C...). On the other hand, cells are address with a letter and a number (A1, B7, Z44). You may 

enter, text, numeric value or formulas to these cells. The text you have entered will act as labels 

whereas the numbers will be your data. The formula you have entered will calculate the result you 

wanted. 

Ranges 

In Microsoft Excel, a range is a rectangular region. A range is defined using its cell addresses of 

their opposing cells. Ranges are used in operations such as summation and averaging. 

Ex: 

A1:A5 Addresses the first five cells of A column and it contains A1, A2, A3, A4 and A5 

B2:E3 contains B2, B3, C2, C3, D2, D3, E2, E3 

Formatting 

You may need to change the format of the worksheets you have prepared for printing or viewing. 
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There are two types of formatting: cell formatting and data formatting. To begin formatting you 

should select the cells you wish to format. There are ready-to-use cell formats located in the 

“Home” menu, under the “Cell styles” section, you can either use these or create your own style 

using “Font” section. If you wish to change the size of columns or rows, you can use the ruler that 

shows column and row addresses. Position your mouse cursor between two row or columns and 

hold left mouse button, moving the mouse will change the width or height of the cell. Release the 

mouse button after you are done. 

“Home” menu contains “Number” section for you to change number format. You may use the list 

on this section to choose an item from it. In this list, previews of the number formats are shown 

below. If the formatting you require does not exist in the list, you may click “More number formats” 

item to form the format you wish. Moreover, this number section contains buttons to control the 

decimal digits to be shown ( ). 

Formulas 

In Excel, you can assign formulas to cells instead of simple values. The result of a formula is 

dynamically calculated and shown in the cell you have entered the formula in. For instance: you 

may sum the value of cells F1, F2, and F3 and display in F4 using the formula  =F1+F2+F3. You 

only need to start with “=” symbol to create a formula. 

Functions 

You may use functions in your formula. Some of these functions work with ranges. If we want to 

rewrite the previously given sample we can use SUM function to obtain same result using 

=SUM(F1:F3). If you want to see the list of all defined functions you can use the “Insert function” 

button (fx). The following is the list of most commonly used functions. 

• SUM: Sums all the values in the given range 

• AVERAGE: Takes the average of the numbers in the given range 

• MIN, MAX: Finds maximum or minimum value in the given range. 

• SUBSTITUTE: Substitutes all occurrences of the second parameter with the third parameter 

in the first parameter. Ex: SUBSTITUTE(F1, "one", "two") 

• POWER: Finds the power of the first parameter to the second one. Ex: POWER(F1, 2) 

Moving and Copying Formulas 

If you move or copy a formula, the addresses or range information inside the formula is also 

changed. For instance, if you move =SUM(F1:F3) formula in the F4 to cell E6, the formula will 
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automatically become =SUM(E3:E5). 

If you do not want the formulas you copy to change, you can use “$” symbol in your cell or range 

addresses. You can use this symbol either for column, row or for both. If you alter the previous 

formula to =SUM($F$1:$F$3) it will not change when you move it. 

Data 

In Microsoft Excel, there are tools that help you to work with data sets. These tools are located in 

“Data” menu. The most basic functionality in here is sorting and filtering. Using these tools, you 

can easily find the record you search, even in crowded documents. For instance, you can easily 

filter your customers to see who is living in “Magusa”. Similarly you can sort your customers by 

the products they buy to see who are buying more. These operations treat your data in rows, 

therefore you need to organize your data as such. 

To sort the data you have, you can use the sort button located in “Data” menu. After selecting your 

data, click on one of these buttons. A dialog will appear which allows you to choose how to sort the 

selected data. 

Filtering data requires data processing mode to be activated. You can activate this mode by selecting 

your data and clicking “Filter” button. This operation will consider first row you have selected as 

captions. If you do not have a header row, you should add one before starting data processing mode. 

The captions located in the header row defines your column information (Customer name, sales, 

etc...). When data processing mode starts, Excel will assign drop down icons to each column. When 

you click on this symbol a menu containing filtering and sorting tools will appear. You may filter 

your data using this column operations menu. Microsoft Excel will produce some automatic filters 

for you. These filters are generated with regards to the data entered to that column. For instance, if 

your column contains date information, generated filters will contain years, months and days in a 

tree fashion. From this list you can easily select a month or the days you want to see. If this list does 

not contain the filter that you want to use, you can also create the filter you want. You may learn the 

details of this operation from the help menu. Apart from filtering, its possible to sort data in data 

processing mode. 

Charts 

To insert a chart, first select the data you need. You need to select a caption row and a caption 

column. For instance, let’s assume that column A contains dates and column B contains the sales in 

those dates. To create the sales chart, firstly add “Dates” to the top of column A and “Sales” to the 
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top of column B. Then, select both columns. If it is desired, multiple columns can be shown in the 

same chart. Total price can be added to the previous sample. Similarly, this column should have a 

caption and should be selected. After selecting data go to “Insert” menu, click the chart type you 

want to add and select the subtype from the list, your chart will be placed on your worksheet. 

After adding the chart, you may select it to access its properties. Selecting the chart will activate 

“Design”, “Layout” and “Format” menus. In “Design” menu, “Chart layout” section contains 

presets that changes the legend and location of the data labels. The “Chart design” section contains 

preset formats that change chart options such as color and shades. You may also use “Layout” and 

“Format” menus control layout and format options by yourself. 

Note: To select non-sequential data, select the first area then hold CTRL button and select the 

second area. 

 

Experimental Work 

1. Prepare the following table, try to modify your table to look like the given sample below. 

Course Credits Degree Value Credits earned 

CMPE 101 4 A 4  

PHY 101 4 B 3  

CMPE 102 4 B+ 3.3  

MAT 151 4 B- 2.7  

MAT 163 3 A- 3.7  

     

Total credits earned     

Total credits     

GPA     

 

2. In the row containing CMPE 101, add the formula that calculates the multiplication of 

“Credits” and “Value” columns to the “Credits earned” column. The result should be 16. 

3. Copy the formula you have prepared in step 2 to other course rows. The values displayed 

should be: 12, 13.2, 10.8 and 11.1 

4. Write the formula that calculates the total credits earned next to the “Total credits earned” 

label. The value should be 63.1. 

5. Write the formula that calculates the total credits of the courses to the respected cell. This 
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value should be 19. 

6. Use the following formula to calculate the average. The correct result of this formula should 

be 3,3210526. 

𝐺𝑃𝐴 =
𝑇𝑜𝑡𝑎𝑙𝑐𝑟𝑒𝑑𝑖𝑡𝑠𝑒𝑎𝑟𝑛𝑒𝑑

𝑇𝑜𝑡𝑎𝑙𝑐𝑟𝑒𝑑𝑖𝑡𝑠
 

7. Adjust the GPA cell to show only two digits after decimal separator (result: 3.32) 

8. Change CMPE 101 to A and its value to 4, and follow the changes. 

9. Sort the courses table according to value column. You may refer to Section named . 

10. Add a pie chart to your worksheet that shows the contribution ratio of every course. To do 

this you have to create your chart from course names (including the header) and credits earned 

column. Modify your chart to look like the one given on the next page. 

11. Filter your courses table to show courses that have credit value of 4. You may refer to the 

section . 

 

 


